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 Introduction 

1.

This document describes the concepts required to use the iDirect module as part of the AAQ Controller. This module 
directly supports iDirect modems Evolution X3, X5, X7, and the Evolution 8000 Series. It is recommended that older 
iDirect modems should be upgraded to software version iDX 3.5.  

iDirect Evolution modems are an IP-based satellite communications system engineered to deliver the highest quality 
broadband connectivity. The Platform is built on DVB-S2/ ACM with Adaptive TDMA and multiple technologies to 
allocate bandwidth efficiently over distributed networks, while automatically adjusting to dynamic traffic demands and 
changing network conditions. 
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 Setup Guide 

2.

2.1. Hardware 

 iDirect Modem  

o Evolution X3 

o Evolution X5 

o Evolution X7 

o Evolution 8000 Series 

 AvL AAQ Antenna System 

 

2.2. Software 

Ensure that the Remote Client, ROM, and device module are at or above the versions shown in Figure 1: 

 

 

Figure 1 – Version Info 

Note:  It is recommended that older iDirect modems should be upgraded to software version iDX 3.5. 

 

2.3. Hardware Connection 

Connect the AAQ antenna controller to the iDirect modem through the desired means.  The AAQ controller supports 
serial (RS232) and Ethernet communications to the iDirect modem and can be configured to use either depending on 
the necessary networking scheme. 
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2.3.1. Serial Communication Connection 

To communicate with the iDirect modem through a serial connection, connect the serial cable from the AAQ antenna 
system to the Console port on the modem. Connect power to all devices. Confirm that the serial port settings are 
correct per section 3 of this document. 

 

 

 
Figure 2 – Serial Setup 

 

2.3.2. Ethernet Communication Connection 

When setting the system to communicate by Ethernet, connect both the controller and the iDirect modem to the AvL 
CIP or other network switch so the controller can query the modem over the network.  Ensure power is connected to 
each device. Confirm that the Ethernet settings are correct per section 3 of this document. 

 

 

Figure 3 – Ethernet Setup 
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When setting the system to communicate by Ethernet, it is important to make sure the controller has a network path    
to the iDirect modem so the controller can query the modem over the network.  The example shown below 
represents a typical installation. 

 

Path 

Main Window  File  Settings AAQ Network Interface Options 

Level 1 

 

 

Figure 4 - AAQ Network Interface Option Window 

 

 

 Configuration 
3.

3.1. Core Configuration Items 

Modify the following configuration items to enable interaction of the controller with the modem.  These configuration 
items can be accessed using the AAQRemote GUI.  The configuration varies depending upon the physical connection 
method (Ethernet or serial).   

 

Path 

Main Window  View  Configuration Core 
Level 4 
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Figure 5 - Core Configuration Window, System Configuration 

 

3.1.1. Ethernet Setup 

If configuring to communicate over Ethernet set the iDirect module to use the IP address and Port Number of the 
iDirect modem. 

 

Long Name Level Type Value Range Documentation 

iDirect Com Port 4 String 
iDirect IPv4 
Address 

The factory set IPv4 address of the iDirect 
modem  

iDirect Com Port 
Settings 

4 String 23 The standard Telnet Com Port 
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3.1.2. Serial Setup 

If configuring to communicate over Serial, set the iDirect module to use the RS 232 com port and Port Number of the 
iDirect modem. 

 

Long Name Level Type Value Range Documentation 

iDirect Com Port 4 String 
/dev/ttyO0 or 
/dev/ttyO3 

The computer device filename for the 
communications port used 

iDirect Com Port 
Settings 

4 String 

BaudRate, 
DataBits, 
Parity & 
StopBits 

The communications parameters for the comm 
port in the form of BaudRate, DataBits, StopBits, 
Parity (i.e. 9600 8 1 0) where parity values are 0 
for none and 1 for even. 

 

3.1.3. iDirect Specific Configuration 

Path 

Main Window  View  Configuration Core 
Level 4 

 

 

Figure 6 - Core Configuration Window, Module Configuration 
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Long Name Level Type 
Value 
Range 

Documentation 

iDirect Console 
Password 

1 String - This is the Console Password used to log into the modem 

iDirect Console 
Username 

1 String - This is the Console Username used to log into the modem 

iDirect Manual 
Offline 

4 String - 

This is a flag to manually command the modem to go 
offline. Telnet must be active. 

0 = disabled 

1 = enabled 

iDirect Manual 
Online 

4 String - 

This is a flag to manually command the modem to go 
online. Telnet must be active. 

0 = disabled 

1 = enabled 

iDirect SNR Lock 
Threshold 

1 String - The SNR value that is necessary to declare lock 

iDirect Socket 
Delay 

1 String - 
The amount of delay to add to the socket read in 
microseconds 

iDirect Telnet 
Command 

1 String - 
The Telnet Command the iDirect requires to begin a Telnet 
session 

iDirect Telnet 
Password 

1 String - 
This is the Telnet Password used when accessing Telnet 
within the modem 

iDirect Telnet 
Username 

1 String - 
This is the Telnet Username used when accessing Telnet 
within the modem 

iDirect Use 
Automated TX 
Offline Logic 

1 Value 0-1 

The setting to use the automated transmit offline logic to 
protect against adjacent satellite interference. 

0 = Do not use transmit logic 

1 = Use transmit logic. Perform offline commands 

 

3.2. Target Configuration Items 

The two iDirect target configuration items can be accessed using the AAQRemote GUI.    

Path 

Main Window  View  Configuration Target 
Level 1 
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Figure 7 - Target Configuration 

Long Name Level Type Value Range Documentation 

iDirect Beam ID 1 Value 0 - 9999 
The Beam ID the controller will set the iDirect  
modem to use during acquisition if ‘iDirect Use 
Beam Selection’ is set to ‘True’ 

iDirect Use Beam 
Selection 

1 Choice True - False 
Set this switch to True to have the controller 
control the Beam ID the iDirect modem will use 
for acquisition 

Scan Source 1 Choice 
All available 

signal sources 
The Signal Source used to Scan for the Target 
satellite. Set this to iDirect. 

Coarse Source 1 Choice 
All available 

signal sources 
The Signal Source used to Coarse Peak on the 
Target satellite. Set this to iDirect. 

Fine Source 1 Choice 
All available 

signal sources 
The Signal Source used to Fine Peak on the Target 
satellite. Set this to iDirect. 
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3.3.  Signal Configuration Items 

The controller polls the modem for signal information that is used to correctly point the antenna.  In this case the 
modem’s SNR value is used to peak the signal at its maximum.  The following are recommended settings to ensure the 
movement of the physical antenna is not faster than the polling speed of the signal data.  

 

Path 
Main Window → View  Configuration Signal 
Level 4 

 

 

Figure 8 - Signal Configuration Window 
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Long Name Level Type Value Range Recommended Value Documentation 

Coarse Peaking 
Cycles 
Maximum 

4 Integer 0 to 10 1 
The maximum number of 
cycles to attempt for 
coarse peaking. 

Coarse Peaking 
Cycles 
Minimum 

4 Integer 0 to 10 1 

The minimum number of 
cycles to attempt for 
coarse peaking. [Note: If 
set to 1 Coarse Peaking 
Cycles Maximum will be 
ignored] 

Coarse Peaking 
Mode 

4 Choice 

None, 
CrossPattern, 
StepPatten, 

PlateauPeaking 

CrossPattern 
Selection of the peaking 
method to use for coarse 
peaking routines 

Cross Pattern 
Coarse 
Azimuth 
Velocity 

4 Float .02 to 1 0.2 
Azimuth velocity in 
degrees/sec for coarse 
peaking 

Cross Pattern 
Coarse 
Elevation 
Velocity 

4 Float .02 to 1 0.2 
Elevation velocity in 
degrees/sec for coarse 
peaking 

Cross Pattern 
Coarse Peaking 
Height 

4 Float .25 to 5 1 
Height in degrees to scan 
during a coarse cross 
pattern peaking function 

Cross Pattern 
Coarse Peaking 
Width 

4 Float .25 to 5 2 
Width in degrees to scan 
during a coarse cross 
pattern peaking function 

Cross Pattern 
Coarse Signal 
Tolerance 

4 Float 0 to 1000 10 
Signal degradation 
amount before a scan 
stops 

Cross Pattern 
Fine Azimuth 
Velocity 

4 Float 0.02 to 0.5 0.1 
Azimuth velocity in 
degrees/sec for fine 
peaking 

Cross Pattern 
Fine Elevation 
Velocity 

4 Float 0.02 to 0.5 0.1 
Elevation velocity in 
degrees/sec for fine 
peaking 
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Cross Pattern 
Fine Peaking 
Height 

4 Float 0.25 to 5.0 0.5 
Height in degrees to scan 
during a fine cross 
pattern peaking function 

Cross Pattern 
Fine Peaking 
Width 

4 Float 0.25 to 5.0 1.00 
Width in degrees to scan 
during a fine cross 
pattern peaking function 

Cross Pattern 
Fine Signal 
Tolerance 

4 Float 0.0 to 1000 10.0 
Signal degradation 
amount before a scan 
stops 

Fine Peaking 
Cycles 
Maximum 

4 Float 1 to 10 1 
The maximum number of 
cycles to attempt for fine 
peaking 

Fine Peaking 
Cycles 
Minimum 

4 Float 1 to 10 1 

The minimum number of 
cycles to attempt for fine 
peaking [Note: If set to 1 
Fine Peaking Cycles 
Maximum will be 
ignored] 

Fine Peaking 
Mode 

4 Choice 

None, 
CrossPattern, 
StepPatten, 

PlateauPeaking 

CrossPattern 
Selection of the peaking 
method to use for fine 
peaking routines 

Line Scan 
Failure 
Elevation Step 
Size 

4 Float 0.0 to 5.0 1 
The amount of each El 
step to make when an Az 
scan fails 

Line Scan 
Maximum 
Elevation 
Steps 

4 Float 1.0 to 50 0 

Initial scan plus the 
number of El steps to 
make when an Az scan 
fails 

 

 

3.4. Feed Configuration Items 

There are not Feed configuration items associated with this module. 

 

 Functional Overview  

4.

When properly configured, the iDirect modem is fully integrated into the AvL AAQ’s acquisition process, and can be used 
as a signal source to acquire and track on satellite signals. Once the target satellite has been found, the modem will log 
into the network and be ready to send traffic.  
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4.1. Acquisition Process 

 

Figure 9 - Acquire Command 

1. Power up the antenna 

2. Command the antenna to acquire  

The AAQ will initialize sensors, read the compass, then proceed to the first scan point 

3. The antenna detects a lock from the modem and stops 

The Modem has detected the satellite carrier 

The AAQ has stopped its scan 

4. The AAQ will coarse peak back to the signal 

This is the initial coarse peak that will move through the entire beam 

5. Once coarse peaking has been completed, fine peaking will begin 

This fine peaks the signal using small, slow movements 

6. AAQ will stop movement  

The AAQ has enabled transmit on the modem 

The Modem will log into the network and be ready to send traffic 

 

 

 

 

4.2. Sensor Outputs 

 

Path 

Main Window → View→ Sensor Output 

Level 0 
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Check the boxes beside any Sensor Outputs you wish to view for monitoring operations. 

 

 

Figure 10 – Sensor Output 

The table below describes the Sensor Outputs relevant to this module 

Item Description 

iDirect Beam Name If entered, this is the customers name for each beam in a network. 

iDirect Detected Noise 
A measure of unwanted signal power used for  calculating the SNR 
(Signal Noise Ratio) 

iDirect Min Lock Signal Not used in iDirect R11.9 – Display zero 

iDirect Min Valid Signal Not used in iDirect R11.9 - Display zero 

iDirect Rx Lock Flag that indicates whether iDirect unit has declared carrier lock. 

iDirect Rx Signal Receive signal strength as read from modem. 

iDirect Signal Average Readout of average signal as read from AAQ 

iDirect Signal Gradient 
Mathematical approximation of signal change over time in coordination 
with “iDirect Gradient Sample Time” config. Item as read from AAQ. 

 

 

4.3. Module Window 

4.3.1. Device Window 

From the AAQRemote GUI, open the Device Window.  The module returns data from its communications in this 
window.   

Path 

Main Window → View→ Device Window 

Level 0 



 

 

     iDirect Modem 

 

 

 

AvL Technologies | Proprietary – Content is Subject to Change without Notice                 

15 

 

 

Figure 11 – Device Window 

Item Description 

Rx SNR The Signal to Noise Ratio reported by the modem.  

Modem Locked The locked status of the iDirect modem. 

AAQ Locked The locked status of the controller. 

Console Logged in A true or false indicator that shows if the controller has successfully 
logged into the console interface. 

Telnet Logged in A true or false indicator that shows if the controller has successfully 
logged into the telnet interface 

Error Msg Displays the current error message: 
  None = No issues 
  Port size=X Set size=Y = User has not provided network/com settings 
  Bad Write to Modem = Controller was not successful sending data 
  Comm. Timeout = Controller did not receive data from the modem 

Debug Displays debug information such as a sample of the string sent to the 
modem.   

Modem Locked The locked status of the iDirect modem. 

 
4.3.2. Device Control Window 

A Device Control Window is not needed for monitoring operation and is not included in the software. 

 

 Issues and Troubleshooting 

5.

Issue Description Corrective Action 

AAQ will not communicate to 
Modem 

Device Window does not say 
“iDirect” at the top 

Check that the module has been 
installed.  This can be done through 
the AAQRemote GUI’s Help→Version 
Info. 

Check that the iDirect is configured as 
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the Scan, Coarse, and Fine Source for 
the selected Target 

AAQ will not communicate to 
Modem 

System in an alarm state 
“iDirect- Not Ready” 

Device Window shows “Not 
Connected” or “Establishing 
Comms” 

Check the configuration items and 
make sure the iDirect modem module 
is configured to communicate through 
Serial or Ethernet. 

Check Serial or Ethernet cables and 
connections. 

AAQ will not log into the 
Modem 

The Device Window item 
“Console Logged in” is false. 

Check that the Console username and 
password in the Core Configuration 
are correct for the modem.  

AAQ will not log into the 
Modem 

The Device Window item 
“Telnet Logged in” is false. 

Check that the Telnet username 
and/or password in the Core 
Configuration are correct.   

The appropriate Telnet command 
should also be identified.  The default 
value “telnet 0” could be modified by 
the iDirect options file.  In some cases 
this changes the location of the telnet 
to a specific IP address (ex. “telnet 
10.1.1.1”). 

AAQ will not acquire or loses 
Signal Lock during Peaking 

“All signal sources tried with no 
valid signal detected” or “Invalid 
Signal For Peaking” error 
message reached after an 
attempted acquire. 

Check that the AAQ is communicating 
with the modem. 

Check that the correct target profile is 
selected and that it is configured 
properly. 

Check that the Scan and Peaking 
parameters are configured correctly 
in the Signal tab of the Configuration 
Window 

Check all RF cables and connections. 

 


